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Image	source	ResourcesGame	Design	Written	by	Josh	Petty	Disclosure:	This	post	may	contain	affiliate	links.	That	means	if	you	buy	something	we	get	a	small	commission	at	no	extra	cost	to	you(learn	more)	For	those	looking	to	learn	game	development	there’s	no	better	place	to	start	than	Unity.	It’s	the	game	engine	of	choice	for	indie	developers	and	a
popular	tool	among	major	studios.	Whether	you’re	making	a	sidescroller	or	a	top-down	shooter,	there	are	huge	benefits	in	starting	with	2D	work	since	it’s	so	much	simpler.	And	with	websites	like	opengameart.org	you	can	find	plenty	of	2D	assets	to	use	in	your	projects.	Unity	3D	doesn’t	have	a	dedicated	2D	engine	like	GameMaker	or	Godot,	but	it’s
perfectly	capable	of	handling	all	your	2D	needs.	Unity’s	physics	engine	ships	with	rigidbodies	and	collision	components	designed	specifically	for	2D	games,	meaning	you	can	get	2D	behavior	right	out	of	the	box.	So	let’s	dive	into	these	tutorials	and	start	learning!	One	of	the	best	things	about	Unity	is	the	large	community	it	has	attracted	over	the	years.
Lots	of	talented	artists	and	game	designers	have	shared	their	expertise	with	the	engine	in	the	form	of	online	tutorials.	With	these	tutorials	you	can	learn	game	development	free	of	charge.	The	best	part	of	these	tutorials	is	that	many	of	them	are	in	real-time.	This	makes	it	not	only	easier	to	follow	along,	but	you	also	get	a	real	sense	of	how	long	it	takes
to	make	a	game.	Intro	to	Unity	Check	Out	This	Tutorial	This	brief	introduction	to	Unity	by	Daniel	Wood	is	everything	you	need	to	get	started	with	the	game	engine.	He’ll	walk	you	through	downloading	and	installing	Unity	to	get	you	moving	from	square	one.	Unity	comes	with	everything	necessary	for	making	games	and	it	can	be	intimidating	when	you
first	open	the	program.	After	installing	Unity,	Wood	will	walk	you	through	the	complex	GUI.	Before	you	can	start	making	games	you	need	to	know	what	you’re	looking	at.	Once	you	learn,	for	instance,	the	difference	between	the	hierarchy	and	the	scene	view,	you	can	safely	move	onto	practicing	your	own	2D	projects.	Check	Out	This	Tutorial	If	you’re
just	starting	out	with	Unity	then	you’re	probably	itching	to	make	your	dream	game.	Maybe	it’s	a	2D	platformer	like	Sonic	the	Hedgehog	or	even	the	ultimate	Metroidvania.	Unfortunately	before	you	can	run	around	the	screen	collecting	golden	rings,	you’ll	need	to	build	a	player	controller.	Building	a	good	character	controller	can	be	a	challenge	even
for	seasoned	developers.	Lucky	for	you	this	tutorial	by	expert	game	instructor	Brackeys	will	show	you	how	to	get	a	2D	character	up	and	running	in	a	matter	of	minutes.	Using	Brackeys’	character	controller	will	allow	you	to	get	started	quickly	so	that	you	can	focus	on	building	the	rest	of	your	game.	Later	after	you’ve	spent	more	time	in	Unity	you	can
try	making	your	own	character	controller.	Check	Out	This	Tutorial	Tilemaps	are	a	great	tool	for	making	2D	levels.	There	are	a	lot	of	benefits	to	using	Tilemaps	which	is	why	they’re	still	a	popular	choice	for	2D	developers.	Games	like	Mario	and	Pokemon	used	Tilemaps	to	save	space	on	their	limited	hardware.	Modern	games	like	Stardew	Valley	and
Spelunky	use	Tilemaps	to	make	level	design	more	modular.	Unity	has	several	tools	that	make	using	Tilemaps	easy.	To	create	your	own,	all	you’ll	need	is	an	image	containing	the	tiles	you	want	to	use.	Unity	can	slice	the	file	into	individual	tiles	and	add	collision	for	you.	Check	Out	This	Tutorial	Here’s	another	guide	from	Brackeys	that	covers	the	basics
of	making	a	2D	platformer	complete	with	a	working	player	and	a	scrolling	background.	You’ll	learn	a	lot	of	techniques	in	this	video.	There’s	a	lot	more	involved	with	making	even	a	very	simple	game	like	the	original	Super	Mario	Bros.	Brackeys	will	teach	you	how	to	handle	parallax	scrolling	and	tiling	so	that	your	levels	have	depth	and	emersion.	He’ll
also	cover	character	movement	and	animation	so	that	you	can	traverse	your	2D	world.	Check	Out	This	Tutorial	2D	RPG’s	have	remained	popular	over	the	years	for	a	variety	of	reasons.	Thanks	to	the	explosion	of	indie	developers	we’ve	seen	new	games	released	that	both	harken	back	to	and	expand	this	genre.	With	Unity	you	can	make	your	own	2D
RPG.	This	video	series	by	gamesplusjames	will	teach	the	basics	of	creating	a	top-down,	action	RPG.	You’ll	learn	how	to	build	2D	worlds	with	sprites	and	add	a	character	controller	to	make	your	player	move	and	attack.	By	the	end	you’ll	know	enough	to	make	your	own	simple	RPG	game.	Check	Out	This	Tutorial	One	of	my	favorites	parts	of	game
development	is	seeing	animated	characters	come	to	life	in	the	game	world.	And	with	Unity	it’s	easy	to	animate	2D	characters.	But	how	do	we	get	frames	for	our	animations?	That’s	where	Sprite	Sheets	come	in.	Arranging	the	frames	of	an	animation	on	a	single	image	will	make	it	far	easier	to	animate.	Making	a	Sprite	Sheet	in	Photoshop	is	a	somewhat
tricky	procedure.	You’ll	need	to	create	a	new	image	with	the	necessary	dimensions	depending	on	the	size	of	your	sprite	and	then	manually	lay	out	the	frames.	That’s	where	this	video	comes	in	to	help.	Once	you’re	done	you’ll	have	a	file	that’s	easy	for	Unity	to	slice	and	turn	into	animations	that	you	can	call	from	script.	With	some	practice	you	can
quickly	build	pixel	art	games	without	a	struggle.	Check	Out	This	Tutorial	Last	year	Unity	introduced	new	animation	features.	Now	game	developers	can	rig	their	2D	sprites	right	inside	the	Unity	editor!	Rigging	your	2D	characters	will	make	animating	them	much	easier	and	faster	than	drawing	each	frame	by	hand.	Using	the	Sprite	Editor	in	Unity,
sponsored	instructor	Sykoo	will	show	you	how	to	rig	a	2D	character	and	animate	it.	You	can	use	this	process	to	animate	anything	you	want.	Once	you’ve	created	your	animations	using	the	bones	of	your	rig,	you	can	use	Unity’s	Animator	tool	to	control	the	transitions	between	your	various	animations.	Check	Out	This	Tutorial	In	this	Unity	tutorial	by
Blackthronprod	you’ll	learn	a	good	method	for	adding	melee	combat	to	your	game.	With	just	a	few	scripts	you	can	design	your	character	to	slash	enemies	with	a	weapon.	By	the	end	of	this	video	you’ll	have	a	working	attack	and	enemy	health.	Blackthronprod	shows	you	how	to	easily	add	particle	effects	when	the	enemy	is	hit	to	create	visual	feedback.
This	technique	will	work	for	almost	any	weapon	you	can	think	of.	With	some	simple	tweaks	you	can	quickly	create	a	spear	or	a	dagger	for	your	player	to	use,	or	really	anything	you	want.	After	you’ve	created	the	scripts	Blackthronprod	will	teach	you	how	to	customize	the	hit	box,	damage,	range,	and	attack	speed	from	inside	the	Unity	editor.	Check	Out
This	Tutorial	In	this	tutorial	from	Brackeys	you’ll	get	an	in-depth	look	at	shooting	bullets	in	Unity.	You’ll	learn	the	differences	between	two	types	of	shooting:	prefabs	and	raycasting.	Each	has	its	own	strength	and	weakness	so	it’s	up	to	you	to	decide	how	to	use	them.	Using	a	character	that	looks	suspiciously	like	Samus	from	the	Metroid	series,
Brackeys	walks	you	through	firing	bullets	using	prefabs	before	moving	onto	raycasts.	By	the	end	you’ll	have	a	thorough	understanding	of	each	method.	Check	Out	This	Tutorial	A	good	camera	system	can	make	or	break	your	game.	With	the	introduction	of	Cinemachine	Unity	now	provides	many	cameras	for	you.	Using	the	Unity	2D	camera	will	provide
you	with	a	virtual	camera	that	can	be	set	to	target	the	player	object.	With	Cinemachine	you	can	very	easily	create	a	perfect	2D	game	camera.	Brackeys	will	show	you	how	to	adjust	the	settings	to	get	a	wide	range	of	behaviors	including	smoothing	and	a	look-head	feature.	Having	a	solid	camera	will	instantly	improve	your	game	no	questions	asked.
Check	Out	This	Tutorial	In	this	basic	tutorial	from	Code	Monkey	you’ll	learn	how	to	create	a	health	bar	using	sprites	and	a	simple	script.	This	technique	will	work	for	any	game	that	you	want	to	add	a	health	bar	onto.	With	Unity	it’s	possible	to	create	extensive	UI	systems	with	menus	and	stats	or	anything	else	you	could	want.	Starting	with	the	basics,
you’ll	see	how	easy	it	is	to	add	a	graphic	to	your	heads-up-display,	or	HUD	for	short.	Next	you’ll	create	a	new	C#	script	that	controls	the	size	of	the	graphic.	For	a	bonus	effect	Code	Monkey	will	show	you	how	to	make	the	health	bar	flash	when	it’s	nearly	depleted.	Check	Out	This	Tutorial	Every	game	includes	some	example	of	a	user	interface.
Whether	it’s	the	start	menu,	pause	screen,	or	a	health	bar,	UI	is	a	substantial	part	of	game	development.	And	thankfully	Unity	comes	with	a	powerful	set	of	tools	for	creating	UI	elements	for	every	one	of	your	games.	This	video	by	Blackthronprod	will	cover	everything	you	need	to	know	about	UIs	in	Unity.	Using	the	UI	Canvas,	Unity	developers	can
easily	adapt	their	elements	to	different	displays,	making	it	easy	to	port	their	games	to	different	devices.	Check	Out	This	Tutorial	One	of	the	best	things	about	Unity	is	the	robust	cross-platform	support.	In	many	ways	Unity	is	perfect	for	mobile	development	and	adding	touch	controls	to	your	game	is	a	simple	process.	This	video	by	Brackeys	will	get	you
started	making	your	own	mobile	games.	He	uses	iOS	but	if	you’re	working	with	Android	the	process	is	similar.	You’ll	learn	how	to	connect	your	device	to	Unity	for	real-time	testing	before	adding	touch	controls	and	UI	elements	to	your	app.	By	the	end	you’ll	know	how	to	add	a	joystick	to	your	mobile	game	and	use	it	to	control	a	character.	Check	Out
This	Tutorial	Effectors	offer	a	powerful	way	to	add	complex	physics	and	other	behaviors	to	your	game	without	having	to	write	any	code.	Adding	an	Effector	to	a	game	object	will	change	the	way	it	behaves	in	the	game	world.	Effectors	are	a	very	useful	technique	that	can	save	you	a	lot	of	trouble	in	the	long	run.	For	example,	the	Buoyancy	Effector	can
be	used	to	add	realistic	floating	effects	to	your	game.	And	with	the	Platform	Effector	you	can	create	a	one-way	platform	in	seconds.	There’s	a	lot	more	you	can	do	with	Effectors	too.	Experimenting	with	new	tools	is	part	of	the	fun	of	game	development,	so	be	sure	to	play	with	what	you’ve	learned.	Check	Out	This	Tutorial	This	video	will	walk	you
through	the	entire	process	of	animating	a	2D	character	in	Unity.	You’ll	learn	all	about	setting	up	and	controlling	sprite	sheet	animation	which	is	crucial	for	2D	work.	First	you’ll	see	how	to	create	individual	animations	like	running	or	jumping.	Next	you’ll	move	onto	Unity’s	Animator	tool	to	create	a	finite-state	machine	to	control	the	flow	of	your
animations.	To	complete	the	tutorial	you’ll	see	how	to	call	the	animator	from	script	and	trigger	animations	based	on	player	input.	By	the	end	you’ll	know	exactly	how	to	make	your	own	2D	animated	characters	with	confidence.	Check	Out	This	Tutorial	Looking	into	2D	lighting	can	be	dizzying.	But	with	tis	guide	you’ll	learn	about	creating	advanced
lighting	effects	in	Unity	fast.	Using	free	art	from	the	asset	store	you’ll	learn	how	to	build	a	night	scene	complete	with	streetlights	and	windows.	And	Unity’s	lighting	system	it’s	possible	to	have	pixel	art	interact	with	the	light	source.	This	can	be	used	to	create	a	variety	of	effects	including	a	day	and	night	cycle.	Check	Out	This	Tutorial	This	ten-minute
video	by	GucioDevs	teaches	a	neat	technique	for	creating	a	drop	shadow	that’s	great	for	top-down	2D	games.	Using	a	custom	script,	GucioDevs	creates	a	copy	of	a	sprite	but	darkened	and	below	the	original	image.	Making	it	offset	creates	the	illusion	of	a	light	source	above	the	screen.	Pretty	cool!	If	you	want	people	to	play	your	game	you’ll	need	it	to
stand	out.	Simple	effects	like	this	can	go	a	long	way	towards	making	your	game	fun	and	unique.	Check	Out	This	Tutorial	Here	Code	Monkey	offers	some	tips	and	tricks	for	setting	up	your	2D	scene.	Unity	is,	at	its	core,	a	3D	game	engine.	While	developing	2D	games	in	Unity	is	encouraged,	there’s	some	things	you	can	do	to	make	working	in	2D	easier.
After	setting	up	the	scene	and	camera,	Code	Monkey	walks	you	through	importing	the	utilities	package	which	contains	many	useful	helper	tools.	You’ll	use	one,	TextPopMouse,	to	add	text	at	the	mouse	position	during	runtime.	Use	it	to	get	some	quick	visual	feedback	while	you’re	developing	your	game.	Check	Out	This	Tutorial	Remaking	Pong	is
almost	a	rite	of	passage	for	game	developers.	It’s	a	great	place	to	start	with	learning	any	game	engine,	including	Unity.	In	this	tutorial	Tanay	Singhal	will	teach	you	how	to	setup	the	scene	to	recreate	the	classic	Atari	game	Pong.	In	less	than	20	minutes	you’ll	learn	how	to	move	the	ball	and	paddle	as	well	as	create	a	win	condition.	It’s	easy	to	expand
this	simple	demo	into	a	larger	game	as	well.	Try	adding	other	features	and	effects	to	make	your	Pong	game	more	unique.	Check	Out	This	Tutorial	This	freebie	comes	directly	from	the	Unity	team	as	guest	host	Aurore	Dimopoulos	explores	the	2D	Game	Kit	provided	by	Unity	Technologies.	With	the	2D	Game	Kit	users	can	make	games	without	having	to
write	a	single	line	of	code.	The	kit	includes	a	working	demo	of	a	2D	game	as	well	as	reusable	assets	that	beginners	can	use	to	construct	their	own	games.	Complete	with	art,	sound,	and	premade	behaviors,	the	2D	Game	Kit	assets	are	a	great	way	to	learn	level	design	and	familiarize	yourself	with	the	Unity	editor.	With	these	premium	courses	you’re
able	to	learn	Unity	a	bit	faster	and	with	far	more	detail	than	the	free	stuff	on	YouTube.	These	also	give	you	a	chance	to	learn	from	some	of	the	best	instructors	in	the	business.	They	say	good	habits	make	good	work.	With	the	following	courses	you’ll	be	building	a	strong	foundation	of	habits	that	will	help	you	quickly	progress	in	your	Unity	game	design
practice.	Complete	C#	Unity	2D	Developer	Check	Out	This	Course	This	course	on	Unity	Development	is	everything	you	need	to	get	started	with	C#	and	Unity.	You’ll	learn	C#	and	scripting	while	making	video	games	in	a	fun	and	engaging	environment.	Available	on	Udemy,	this	course	focuses	on	building	a	strong	foundation	for	game	design	and	game
development.	You’ll	learn	by	creating	playable	games	that	would	be	good	enough	to	include	in	a	portfolio.	You’ll	start	with	the	basics	of	coding	in	C#	before	moving	on	to	making	your	own	Brick	Breaker	clone.	As	you	progress	you’ll	eventually	learn	how	to	make	a	2D	platformer	using	Unity’s	Tilemap	tool.	Check	Out	This	Course	So	here’s	a	very
detailed	2D	Unity	course	designed	to	take	you	from	beginner	to	advanced	as	quickly	as	possible.	Funded	by	a	wildly	successful	Kickstarter,	this	course	teaches	crucial	concepts	for	coding	in	C#	as	they	relate	to	game	designers.	After	learning	about	Unity	and	creating	a	simple	2D	game	you’ll	move	onto	building	your	own	path-finding	algorithm.	Know
as	A*	(pronounced	“A	star”),	this	path-finding	algorithm	is	widely	used	within	the	games	industry.	You’ll	get	access	to	all	the	source	files	needed	for	the	projects	as	well	as	some	instructions	on	using	Photoshop	for	game	development.	Check	Out	This	Course	Here’s	a	lengthy	and	detailed	series	that	focuses	on	the	basics	of	2D	development	in	Unity.
This	is	specifically	for	beginners	looking	to	get	their	feet	wet	with	Unity’s	2D	features.	You’ll	first	cover	the	basics	of	setting	up	a	2D	project	before	Unity	guru	Joshua	Kinney	shows	off	Unity’s	sprite	tools	in	great	detail.	Near	the	end	Kinney	will	reveal	the	secrets	of	animating	with	the	Unity	game	engine	to	help	all	aspiring	game	designers	add	life	to
their	work.	Check	Out	This	Course	Creating	a	player	character	is	essential	to	almost	every	video	game.	Unfortunately	it’s	also	one	of	the	most	difficult	things	to	do.	Even	senior	developers	can	spend	weeks	getting	the	player	to	feel	just	right.	Beginners	often	find	a	pre-made	controller	they	can	use	because	they	just	want	to	make	games	as	quickly	as
possible.	At	some	point,	however,	you’re	going	to	need	to	write	your	own.	This	course	by	animator	Brian	Sinasac	teaches	everything	you	need	to	know	about	creating	a	2D	character	in	Unity.	By	the	end	of	this	series	you’ll	understand	how	to	build	a	2D	character	controller	and	have	the	skills	necessary	to	start	your	own	side-scroller	game.	Check	Out
This	Course	Looking	to	learn	to	rig	and	animate	2D	characters	from	inside	the	Unity	editor?	Then	this	is	the	video	series	for	you.	In	this	Pluralsight	course,	game	design	tutor	Shane	Wheldan	teaches	the	fundamentals	of	using	bones	to	animate	characters	in	Unity.	He	covers	everything	from	Z-order	to	Inverse	Kinematics	in	these	lectures.	Using	Unity,
Spriter,	and	Photoshop,	you’ll	learn	everything	you	need	to	make	your	own	2D	video	game	characters	just	like	the	pros.	Check	Out	This	Course	You	might	be	having	a	blast	running	around	your	game	world,	but	unless	there’s	something	to	interact	with,	it	gets	boring	quick.	Interactions	between	game	objects	is	usually	handled	with	a	trigger.	This
series	will	focus	on	using	triggers	and	creating	interactable	objects.	In	the	first	section	you’ll	learn	how	to	create	an	item	for	the	player	to	pick	up.	Then	you’ll	learn	how	to	use	Unity’s	UI	system	to	give	the	player	feedback	about	the	interaction.	By	the	time	you’re	done	you’ll	be	well-equipped	to	build	your	own	side-scrolling	platformer	with	Unity.
Check	Out	This	Course	Collectible	Items	are	a	feature	of	many	games.	They	give	the	player	an	objective	and	can	be	used	for	a	variety	of	purposes.	In	this	video	you’ll	create	a	coin	for	your	player	to	collect.	You’ll	learn	how	to	create	a	script	to	control	the	coins	and	update	the	UI	after	they’ve	been	collected.	As	a	bonus	the	instructor	will	show	you	how
to	reward	the	player	with	an	extra	life	after	so	many	coins	have	been	collected.	Reminds	me	of	an	Italian	plumber	I	used	to	know.	Check	Out	This	Course	Unity’s	physics	engine	makes	it	easier	than	ever	to	make	your	own	games.	This	tutorial	focuses	on	using	this	engine	to	get	the	most	out	of	your	2D	work.	You’ll	learn	all	about	Rigidbodies	and
Colliders	as	you	build	your	own	2D	projects.	The	series	is	long	but	first	you’ll	work	with	the	physics	tools	provided	by	the	editor.	Eventually	you’ll	move	onto	scripting	unique	physics	behaviors	of	your	own.	When	you’ve	complete	this	course	you’ll	have	an	advanced	understanding	of	Unity’s	physics	engine	and	how	to	use	it	to	make	your	own	2D	games.
Note	this	course	does	come	from	Pluralsight	which	offers	everyone	a	free	7-day	trial	with	access	to	all	courses	during	that	period.	So	if	you	have	time	in	a	given	week	you	can	sign	up	to	Pluralsight	for	free,	dig	through	their	Unity	content,	then	cancel	before	being	billed.	Granted	their	courses	are	so	detailed	and	useful	and	it	may	be	worth	subscribing
for	a	few	months	just	to	go	through	everything!	Before	you	create	a	2D	game,	you	need	to	decide	on	a	game	perspective	and	an	art	style.	To	create	a	2D	game,	set	up	your	Unity	project	and	then	familiarize	yourself	with	the	relevant	concepts	in	the	following	order:	Fundamentals	GameObjectsThe	fundamental	object	in	Unity	scenes,	which	can
represent	characters,	props,	scenery,	cameras,	waypoints,	and	more.	A	GameObject’s	functionality	is	defined	by	the	Components	attached	to	it.	More	infoSee	in	Glossary	are	fundamental	objects	in	Unity	that	represent	characters,	props,	scenery,	and	more.	Every	object	in	your	game	is	a	GameObject.	GameObjects	represent	the	items	in	your	game;
the	space	in	which	you	place	them	to	build	your	level	is	called	a	sceneA	Scene	contains	the	environments	and	menus	of	your	game.	Think	of	each	unique	Scene	file	as	a	unique	level.	In	each	Scene,	you	place	your	environments,	obstacles,	and	decorations,	essentially	designing	and	building	your	game	in	pieces.	More	infoSee	in	Glossary.	Scenes	in
Unity	are	always	3D;	when	you	make	a	2D	game	in	Unity,	you	typically	choose	to	ignore	the	third	dimension	(the	z-axis)	but	you	can	also	use	it	in	special	cases,	for	example	when	making	2.5D	games.	The	behavior	of	GameObjects	is	defined	by	blocks	of	functionality	called	components.	The	following	components	are	fundamental	for	2D	games:
Transform:	the	Transform	componentA	Transform	component	determines	the	Position,	Rotation,	and	Scale	of	each	object	in	the	scene.	Every	GameObject	has	a	Transform.	More	infoSee	in	Glossary	determines	the	Position,	Rotation,	and	Scale	of	each	GameObject	in	the	scene.	Every	GameObject	has	a	Transform	component.	Sprite	RendererA
component	that	lets	you	display	images	as	Sprites	for	use	in	both	2D	and	3D	scenes.	More	infoSee	in	Glossary:	the	Sprite	Renderer	component	renders	the	Sprite	and	controls	how	it	looks	in	a	scene.	CamerasA	component	which	creates	an	image	of	a	particular	viewpoint	in	your	scene.	The	output	is	either	drawn	to	the	screen	or	captured	as	a	texture.
More	infoSee	in	Glossary:	devices	that	capture	and	display	the	world	to	the	player.	Marking	a	Camera	as	Orthographic	removes	all	perspective	from	the	Camera’s	view.	This	is	mostly	useful	for	making	isometric	or	2D	games.	Collider	2D:	this	component	defines	the	shape	of	a	2D	GameObject	for	the	purposes	of	physical	collisionsA	collision	occurs
when	the	physics	engine	detects	that	the	colliders	of	two	GameObjects	make	contact	or	overlap,	when	at	least	one	has	a	Rigidbody	component	and	is	in	motion.	More	infoSee	in	Glossary.	See	2D	Physics.	Components	are	UI(User	Interface)	Allows	a	user	to	interact	with	your	application.	Unity	currently	supports	three	UI	systems.	More	infoSee	in
Glossary	representations	of	C#	classes;	you	can	use	scripts	to	change	and	interact	with	components,	or	create	new	ones.	See	the	Scripting	section	for	more	details.	Scripting	All	2D	games	need	scriptsA	piece	of	code	that	allows	you	to	create	your	own	Components,	trigger	game	events,	modify	Component	properties	over	time	and	respond	to	user
input	in	any	way	you	like.	More	infoSee	in	Glossary.	Scripts	respond	to	input	from	the	player	and	arrange	for	events	in	the	gameplay	to	happen	when	they	should.	For	details	on	how	to	use	scripts	in	Unity	see	Scripting	Overview.	Also	see	the	Unity	Learn	Beginner	Scripting	course.	Scripts	are	attached	to	GameObjects,	and	any	script	you	create
inherits	from	the	MonoBehaviour	class.	Sprites	Sprites	are	2D	graphic	objects.	You	use	Sprites	for	all	types	of	2D	games.	For	example,	you	can	import	an	image	of	your	main	character	as	a	Sprite.	A	character	Sprite	You	can	also	use	a	collection	of	Sprites	to	build	a	character.	This	allows	you	greater	control	over	the	movement	and	animation	of	your
characters.	Multiple	Sprites	that	make	up	the	parts	of	a	character,	displayed	in	the	Sprite	Editor	Importing	and	setting	up	Sprites	Import	your	Sprites	with	Unity’s	recommended	settings;	see	Importing	and	Setting	Up	Sprites.	Rendering	Sprites	Use	the	Sprite	Renderer	component	to	render	your	Sprites.	For	example,	you	can	use	the	Sprite	Renderer
to	change	the	color	and	opacity	of	a	Sprite.	Adjusting	the	color	of	a	Sprite	with	the	Sprite	Renderer	See	the	Introduction	to	the	Sprite	Renderer	Learn	tutorial.	Sorting	SpritesBy	organizing	Sprites	in	layers,	you	can	create	an	illusion	of	depth.	You	can	sort	Sprites	according	to	many	strategies.	See	Sorting	Sprites	for	full	details.	For	example,	you	might
sort	Sprites	along	the	y-axis,	so	that	Sprites	that	are	higher	up	are	sorted	behind	Sprites	that	are	lower,	to	make	the	Sprites	that	are	higher	appear	further	away	than	the	Sprites	that	are	lower.	Sprites	sorted	along	the	y-axis	To	set	the	overlay	order	of	Sprites,	use	Sorting	Layers.	To	group	GameObjects	with	Sprite	Renderers,	and	control	the	order	in
which	they	render	their	Sprites,	use	Sorting	Groups.	Sprite	Atlas	You	can	use	a	Sprite	AtlasA	texture	that	is	composed	of	several	smaller	textures.	Also	referred	to	as	a	texture	atlas,	image	sprite,	sprite	sheet	or	packed	texture.	More	infoSee	in	Glossary	to	consolidate	several	Textures	into	a	single	combined	Texture.	This	optimizes	your	game	and	saves
memory.	For	example,	you	can	add	all	your	Sprites	associated	with	a	particular	character	or	purpose	to	a	Sprite	Atlas.	A	Sprite	Atlas	See	the	Introduction	to	the	Sprite	Atlas	Learn	tutorial.	Building	in-game	environments	Environment	design	refers	to	the	process	of	building	your	game’s	levels	and	environments.	You	can	combine	the	environment
design	tools	in	this	section	in	whichever	way	makes	the	most	sense	for	your	game;	for	example,	you	can	make	a	top-down	game	using	only	9-slice,	or	you	can	make	a	side	on	platformer	with	Tilemap	and	SpriteShape.	9-slicing	9-slicing	is	a	2D	technique	that	allows	you	to	reuse	an	image	at	various	sizes	without	needing	to	prepare	multiple	assets.	Unity
can	dynamically	stretch	and	tile	designated	parts	of	a	Sprite	to	allow	one	Sprite	to	serve	as	the	border	or	background	for	UI	elements	of	many	sizes.	See	9-slicing	sprites.	For	example,	you	could	use	9-slicing	to	stretch	a	Sprite	to	shape	when	you	build	a	2D	level.	A	9-sliced	Sprite,	split	into	nine	sections	See	the	Using	9-Slicing	for	Scalable	Sprites
Learn	tutorial.	Tilemap	The	TilemapA	GameObject	that	allows	you	to	quickly	create	2D	levels	using	tiles	and	a	grid	overlay.	More	infoSee	in	Glossary	component	is	a	system	that	stores	and	handles	Tile	assets	for	creating	2D	levels.	Use	the	2D	Tilemap	Editor	package	(installed	by	default)	to	use	Tilemaps.	For	example,	you	can	use	Tilemaps	to	paint
levels	using	Tiles	and	brush	tools	and	define	rules	for	how	Tiles	behave.	The	Tile	Palette	window,	used	to	edit	Tilemaps	See	the	Introduction	to	Tilemaps	Learn	tutorial.	2D	Tilemap	Extras	To	add	some	extra	Tilemap	assets	to	your	Project,	install	the	2D	Tilemap	Extras	package.	This	package	contains	reusable	2D	and	Tilemap	Editor	scripts	that	you	can
use	for	your	own	Projects.	You	can	customize	the	behavior	of	the	scripts	to	create	new	Brushes	that	suit	different	scenarios.	Isometric	Tilemaps	For	games	with	isometric	perspective,	you	can	create	Isometric	Tilemaps.	SpriteShape	In	a	similar	way	to	a	vector	drawing	tool,	SpriteShape	provides	a	more	flexible	way	to	create	larger	Sprites,	such	as
organic-looking	landscapes	and	paths.	See	the	Sprite	Shape	Profile.	A	path	created	in	SpriteShape	See	the	Working	with	SpriteShape	tutorial.	Character	animation	There	are	three	different	ways	you	can	animate	2D	characters:	2D	animation	type	Used	for	Frame-by-frame	Artistic	reasons,	if	you	want	your	game	to	have	a	classic	animation	art	style.
Frame-by-frame	animation	is	relatively	resource-intensive,	both	to	make	and	to	run.	Cutout	Smooth	skeletal	animation,	when	the	characters	don’t	require	realistic	articulation.	Skeletal	Smooth	skeletal	animation	where	Sprites	bend	according	to	the	bone	structure.	Use	this	when	the	characters	need	a	more	organic	feel.	Frame-by-frame	Frame-by-
frame	animation	is	based	on	the	traditional	cel	animation	technique	of	drawing	each	moment	of	an	animation	as	individual	images,	which	are	played	in	fast	sequence,	like	flipping	pages	on	a	flipbook.	To	do	frame-by-frame	animation,	follow	the	Frame-by-frame	Animation	workflow.	Frame-by-frame	animation	in	the	Sprite	Editor	See	the	Introduction	to
Sprite	Animations	Learn	tutorial.	Cutout	In	cutout	animation,	multiple	Sprites	make	up	the	body	of	a	character,	and	each	piece	moves	to	give	the	visual	effect	of	the	whole	character	moving.	This	animation	style	is	similar	to	skeletal	animation	(see	below),	except	that	the	Sprites	don’t	bend.	Cutout	animation	in	the	Sprite	Editor	Skeletal	With	skeletal
animation,	you	map	a	Sprite	or	a	group	of	Sprites	onto	an	animation	skeleton.	You	can	create	and	define	animation	bones	for	characters	and	objects,	that	define	how	they	should	bend	and	move.	This	approach	allows	the	bones	to	bend	and	deform	the	Sprites,	for	a	more	natural	movement	style.	To	use	skeletal	animation,	you	need	to	use	the	2D
Animation	package	(installed	by	default).	For	a	2D	Animation	workflow,	including	a	guide	to	working	with	the	Bone	Editor,	see	the	2D	Animation	documentation.	A	character	with	bones	in	the	Bone	Editor	Graphics	This	section	describes	your	graphics	options	when	using	Universal	Render	PipelineA	series	of	operations	that	take	the	contents	of	a
Scene,	and	displays	them	on	a	screen.	Unity	lets	you	choose	from	pre-built	render	pipelines,	or	write	your	own.	More	infoSee	in	Glossary	(URP).	Lighting	Because	you’re	using	URP	with	the	2D	Renderer,	you	can	use	the	Light	2D	component	to	apply	optimized	2D	lighting	to	Sprites.	For	details,	see	Introduction	to	Lights	2D.	These	two	images	show
the	same	scene;	in	the	image	on	the	left,	2D	Lights	are	disabled,	and	in	the	image	on	the	right,	2D	lights	are	enabled.	With	2D	Lights,	you	can	use	the	same	Sprites	to	create	different	weather	conditions	or	moods.	To	set	up	lighting:	See	the	Lighting	in	URP	Learn	tutorial.	Shadows	To	define	the	shape	and	properties	that	a	Light	uses	to	determine	the
shadows	it	casts,	use	the	Shadow	Caster	2D	component.	Increase	the	Light’s	Shadow	Intensity	above	zero.	A	shadow	intensity	of	0.5	in	the	Shadow	Caster	2D	component	Enhanced	look	and	feel	Particle	systems	and	post-processingA	process	that	improves	product	visuals	by	applying	filters	and	effects	before	the	image	appears	on	screen.	You	can	use
post-processing	effects	to	simulate	physical	camera	and	film	properties,	for	example	Bloom	and	Depth	of	Field.	More	info	post	processing,	postprocessing,	postprocessSee	in	Glossary	are	optional	tools	that	you	can	use	to	add	polish	to	your	game.	Particle	systems	You	can	use	particle	systems	to	create	dynamic	objects	like	fire,	smoke	or	liquids,	as	an
alternative	to	using	a	Sprite.	Sprites	are	more	suited	to	physical	objects.	See	Particle	systemsA	component	that	simulates	fluid	entities	such	as	liquids,	clouds	and	flames	by	generating	and	animating	large	numbers	of	small	2D	images	in	the	scene.	More	infoSee	in	Glossary.	A	fire	effect,	created	with	the	Particle	System	and	Shader	Graph	for	2D	Post-
processing	You	can	use	post-processing	effects	and	full-screen	effects	to	significantly	improve	the	appearance	of	your	game.	For	example,	you	can	use	these	effects	to	simulate	physical	camera	or	film	properties,	or	to	create	stylized	visuals.	URP	has	its	own	post-processing	implementation.	See	Post-processing	in	the	Universal	Render	Pipeline.	The
Lost	Crypt	demo	uses	the	bloom	and	vignette	post-processing	effects	Physics	2D	The	Physics	2D	settings	define	limits	on	the	accuracy	of	the	physical	simulation	in	your	2D	game.	See	2D	Physics.	This	video	provides	an	overview	of	2D	physics	features	in	Unity	2020.1.	To	learn	how	to	use	Unity’s	2D	physics	engineA	system	that	simulates	aspects	of
physical	systems	so	that	objects	can	accelerate	correctly	and	be	affected	by	collisions,	gravity	and	other	forces.	More	infoSee	in	Glossary,	see	the	2D	Physics	Learn	tutorial.	The	following	2D	physics	tools	are	useful	for	2D	games.	Rigidbody	2D	Collider	2D	Triggers	2D	Joints	2D	Effectors	Rigidbody	2D	A	RigidbodyA	component	that	allows	a
GameObject	to	be	affected	by	simulated	gravity	and	other	forces.	More	infoSee	in	Glossary	2D	component	places	a	GameObject	under	the	control	of	the	physics	engine.	See	Rigidbody	2D.	The	Rigidbody	2D	component	Collider	2D	Collider	2D	components	define	the	shape	of	a	2D	GameObject	for	the	purposes	of	physical	collisions.	You	can	also	use
ColliderAn	invisible	shape	that	is	used	to	handle	physical	collisions	for	an	object.	A	collider	doesn’t	need	to	be	exactly	the	same	shape	as	the	object’s	mesh	-	a	rough	approximation	is	often	more	efficient	and	indistinguishable	in	gameplay.	More	infoSee	in	Glossary	2D	components	for	input	detection.	For	example,	in	mobile	games	you	can	use	them	to
make	Sprites	selectable.	The	Collider	2D	types	that	you	can	use	with	Rigidbody	2D	are:	The	Circle	Collider	2D	component	Triggers	When	you	set	a	Collider	2D	as	a	Trigger	(by	enabling	its	Is	Trigger	property),	it	no	longer	behaves	as	a	physical	object,	and	it	can	intersect	with	other	Colliders	without	causing	a	collision.	Instead,	when	a	Collider	enters
its	space,	Unity	calls	the	OnTriggerEnter	function	on	the	Trigger	GameObject’s	scripts.	The	Circle	Collider	2D	component	with	Is	Trigger	selected	2D	Joints	Joints	attach	GameObjects	together.	You	can	only	attach	2D	jointsA	physics	component	allowing	a	dynamic	connection	between	Rigidbody	components,	usually	allowing	some	degree	of	movement
such	as	a	hinge.	More	infoSee	in	Glossary	to	GameObjects	that	have	a	Rigidbody	2D	component	attached,	or	to	a	fixed	position	in	world	space.	See	2D	Joints.	2D	Effectors	Use	Effector	2D	componentsA	functional	part	of	a	GameObject.	A	GameObject	can	contain	any	number	of	components.	Unity	has	many	built-in	components,	and	you	can	create	your
own	by	writing	scripts	that	inherit	from	MonoBehaviour.	More	infoSee	in	Glossary	with	Collider	2D	components	to	direct	the	forces	of	physics	in	your	scene	when	GameObject	Colliders	come	into	contact	with	each	other.	See	2D	Effectors.	Audio	You	can	add	background	music	and	sound	effects	to	your	game	in	Unity;	see	Audio	Overview.	Use	third-
party	software	to	create	your	audio	and	import	it	into	Unity	with	the	recommended	settings.	User	interface	If	you	want	to	add	a	menu	or	help	to	your	game,	you	need	to	set	up	a	user	interface.	To	set	up	a	user	interface,	use	Unity	UI.	Profiling,	optimizing	and	testing	a	build	Profiling	Profiling	allows	you	to	see	how	resource-intensive	the	different	parts
of	your	game	are.	You	should	always	profile	your	game	on	its	target	release	platform;	see	Profiling	your	application.	Optimizing	After	profiling,	you	can	use	the	results	to	make	performance	improvements	and	optimizations.	See	Understanding	optimization	in	Unity.	Testing	Test	your	game	and	your	code	with	the	Unity	Test	Framework;	see	Unity	Test
Framework.	The	Test	Runner	window	Publishing	When	you’ve	finished	your	game,	you’re	ready	to	publish	it.	See	Publishing	Builds.	The	Build	Settings	window	If	you	want	to	make	a	2D	game	with	Unity,	this	guide	is	for	you!	In	this	article,	we’ll	show	you	how	to	create	a	basic	2D	game	in	Unity	using	only	some	built-in	tools.You’ll	have	a	working
concept	for	your	game	by	the	end!There’s	no	doubt	that	2D	games	are	gaining	popularity,	thanks	partly	to	the	ease	of	creating	and	sharing	these	titles	on	platforms	like	itch.io	and	Steam.	But	what	are	the	best	practices	for	creating	a	successful	2D	game	with	Unity?	Here	are	some	critical	steps:Choose	a	genre	or	style	that	you’re	comfortable	with.	If
you’re	just	starting,	stick	to	simple	games,	you	can	polish	quickly.Create	an	exciting	world	or	setting	that	your	players	can	explore.	This	could	be	as	simple	as	a	platformer	with	varied	levels	or	a	strategy	game	with	multiple	nations	vying	for	control	over	different	map	areas.Use	Unity’s	built-in	tools	and	assets	to	create	character	animation,	art,	and
audio	assets.	This	will	help	speed	up	development	and	make	your	game	look	polished.Here	are	some	of	the	common	steps	in	creating	2D	games	with	Unity!1.	Download	the	Unity	GameIf	you	are	looking	to	create	your	2D	games	with	Unity,	one	of	the	first	steps	is	to	download	the	Unity	Game.	There	are	several	benefits	to	downloading	and	using	Unity,
including:2.	Open	Up	UnityDeveloping	a	2D	game	with	Unity	is	a	great	way	to	enter	the	gaming	industry.	One	of	the	advantages	of	using	Unity	is	that	it	offers	a	wide	range	of	tools	and	features	that	make	creating	games	easy.	Additionally,	Unity	provides	an	easy-to-use	editing	platform	that	makes	creating	games	much	more	straightforward	than	other
development	environments.One	of	the	best	ways	to	open	up	Unity	is	to	start	by	downloading	the	software	and	trial	version.	Once	you	have	installed	Unity,	you	can	begin	downloading	free	tutorials	from	the	Unity	website.	After	completing	these	tutorials,	you	can	create	simple	games	without	prior	programming	experience.If	you	are	interested	in
learning	more	about	game	development,	then	you	should	consider	purchasing	one	of	the	many	books	or	courses	available	on	the	market	today.	These	resources	will	teach	you	everything	from	basic	programming	concepts	to	advanced	3D	design	techniques.3.	Create	Your	First	Game	ObjectA	game	object	is	the	basic	building	block	of	a	2D	game	and
enables	you	to	interact	with	the	environment.	By	following	these	simple	steps,	you’ll	be	able	to	create	your	objects	and	scenes	for	your	next	game.	Let’s	get	started!Choose	File	>	New	Project	from	the	menu	bar	at	the	top	of	Unity’s	interface.	This	will	open	up	the	New	Project	window.Select	2D	from	the	category	list	on	the	left	side	of	the	window	and
click	on	the	Create	button	at	the	bottom.	This	will	create	a	new	project	called	“First	Project”.Click	on	First	Project	in	Unity’s	main	menu	and	select	Assets	>	Import	Package	>	Standard	Assets.4.	Add	Some	Life	to	RobotUnity	is	a	powerful	game	development	platform	that	allows	developers	to	create	2D	games	with	relative	ease.	However,	to	give	your
game	some	life,	you	may	want	to	add	some	features	that	allow	users	to	interact	with	the	game.One	way	to	do	this	is	by	adding	a	user	interface	layer	that	allows	players	to	control	their	character	and	interact	with	the	world	around	them.	Additionally,	you	can	add	Unity	features	like	cameras	and	particles	that	help	create	a	more	immersive	gaming
experience.By	taking	these	steps,	you	can	create	a	fun	and	engaging	game	that	will	keep	players	coming	back	for	more.5.	The	Robot	Controller	ScriptWith	Unity,	developers	can	create	games	in	a	variety	of	genres,	from	racing	games	to	first-person	shooters.	One	of	the	steps	that	developers	take	to	create	their	games	is	creating	scripts	for	the	game
controllers.The	Robot	Controller	Script	enables	developers	to	control	characters	and	objects	in	their	game	using	simple	commands.	The	script	contains	variables	that	allow	developers	to	store	information	about	each	object	in	the	game,	and	it	also	contains	functions	that	allow	developers	to	interact	with	these	objects.For	example,	you	can	use	the
function	get	Object	Position	()	to	retrieve	the	position	of	an	object	in	space.6.	Make	a	Blend	Tree	AnimationBlend	trees	are	one	of	the	most	commonly	used	graphical	elements	in	2D	games.	They	provide	a	primary	way	to	show	player	interactions	and	can	be	animated	to	create	a	more	fluid	experience.	We	will	show	you	how	to	create	a	blend	tree
animation	in	Unity	and	then	use	it	in	your	game.First,	you’ll	need	to	create	a	new	project	in	Unity.	If	you	don’t	have	Unity	already	installed,	you	can	download	it	for	free	here.	Once	the	program	is	installed,	open	the	file	menu	and	select	New	->	Project	->	Unity	Project.	Name	your	project	BlendTreeAnimation	and	click	OK.When	the	new	project	is
created,	open	the	Scene	view	window	(Window	->	Show	View	->	Scene).7.	Add	a	ScoreAdding	a	score	to	your	2D	games	can	be	a	great	way	to	add	an	extra	layer	of	polish	and	excitement.	It	can	also	help	players	keep	track	of	their	progress	and	motivate	them	to	continue	playing.	There	are	several	ways	to	add	a	score	to	your	game,	each	with
advantages	and	disadvantages.One	common	way	to	add	a	score	is	to	create	a	separate	Unity	scene	for	the	score	screen.	This	allows	you	to	control	everything	about	the	scoring	system,	from	the	layout	of	the	scoresheet	to	the	animations	used	for	displaying	scores.However,	this	approach	has	two	significant	disadvantages:	first,	it	can	be	challenging	to
track	which	scene	is	displaying	which	scores;	second,	it	can	be	difficult	or	impossible	to	change	or	update	the	scoring	system	in	this	scene	graph.8.	Game	OverThere	are	many	ways	to	create	2D	games	with	Unity,	but	one	common	approach	is	to	use	“Game	Over”	screens	to	tell	the	player	that	their	game	has	ended.	We’ll	show	you	how	to	create	a
simple	Game	Over	screen	using	Unity	and	some	basic	graphics	techniques.First,	we	need	an	introductory	scene	to	contain	our	Game	Over	screen.	This	can	be	created	by	creating	a	new	scene	and	entering	the	following	code	into	the	empty	object:Next,	we	need	to	add	an	Image	component	to	our	Scene	and	attach	an	image	file	called	“gameover.png”
to	it.	This	image	will	be	used	as	our	Game	Over	screen	background:Finally,	to	display	the	Game	Over	screen	when	the	player	completes	the	game,	we	need	to	add	a	few	buttons	to	our	scene.Concepts	in	Setting	Up	2D	Unity	Game1.	FundamentalsUnity	is	a	popular	game	development	platform	that	enables	developers	to	create	2D	games.	Unity	is
famous	for	its	easy-to-use	programming	interface	and	ability	to	generate	high-quality	graphics	quickly.One	of	the	concepts	in	setting	up	a	Unity	game	is	understanding	the	fundamental	principles	behind	how	the	game	works.	This	way,	you	can	ensure	your	gameplay	mechanics	align	with	Unity’s	intended	design	goals	and	avoid	common	problems.Some
fundamentals	behind	Unity’s	2D	gaming	system	are	sprites,	cameras,	collision	detection,	and	more.	By	understanding	these	concepts,	you’ll	be	well	on	your	way	to	creating	your	2D	games	in	Unity!2.	ScriptingScripting	is	a	programming	language	that	developers	use	to	create	games.	A	scripting	language	is	one	of	the	core	concepts	in	game
development,	and	it	can	be	used	for	many	different	tasks	like	creating	objects	or	changing	the	environment	in-game.	Scripts	are	written	in	a	text	editor,	and	they	can	be	compiled	by	Unity	into	bytecode	which	will	run	on	the	target	platform.Scripting	has	become	an	essential	concept	in	setting	up	2D	Unity	Games.	By	scripting,	you	can	automate	game
mechanics	and	create	a	more	controlled	environment	for	your	game.	You	can	also	add	extra	levels	of	complexity	to	your	games	by	scripting	custom	abilities	or	creating	scripted	events	that	occur	during	gameplay.Here	are	some	tips	for	using	scripting	in	your	2D	Unity	Games:Begin	by	understanding	the	basics	of	Unityscript	syntax.	Unity	script	is
similar	to	JavaScript	but	has	additional	features	specific	to	Unity	games.Create	variables	and	scripts	to	control	game	mechanics	and	player	input.	This	will	help	you	streamline	game	development	and	make	your	games	more	user-friendly.Use	event	systems	to	trigger	scripted	actions	based	on	player	input	or	game	conditions.3.	SpritesUnity	is	a	2D
game	creation	platform	that	enables	developers	to	create	games	using	a	simple	drag-and-drop	interface.	Unity	has	many	features	that	make	it	an	attractive	choice	for	developing	2D	games,	such	as	its	built-in	sprites	editor.Sprites	are	one	of	the	critical	concepts	in	setting	up	a	2D	game.	They	allow	you	to	easily	create	characters,	objects,	and	scenery
without	worrying	about	complex	rigging	or	animation.	By	default,	Unity	provides	several	built-in	sprites	templates	that	you	can	use	as	starting	points	for	your	creations.When	creating	your	sprites,	it’s	essential	to	remember	that	Sprites	should	be	designed	based	on	specific	gameplay	requirements	rather	than	aesthetic	considerations.4.	Building	In-
Game	EnvironmentsBuilding	in-game	environments	is	one	of	the	concepts	that	Unity	developers	should	consider	when	setting	up	their	2D	games.	Creating	believable	and	immersive	environments	is	one	of	the	most	critical	aspects	of	game	design.There	are	a	few	different	ways	to	create	an	in-game	environment.	One	approach	is	to	use	pre-made	assets
or	modules	from	third-party	suppliers.	However,	this	can	be	time-consuming	and	prone	to	inconsistency.Another	option	is	to	create	your	textures,	models	and	lighting	effects.	This	can	be	more	challenging	but	ultimately	more	rewarding	because	you	can	control	every	aspect	of	the	scene.	The	critical	thing	to	remember	when	designing	in-game
environments	is	that	they	should	be	believable	and	immersive.5.	Character	AnimationIn	2D	game	development,	character	animation	is	one	of	the	most	fundamental	concepts.	It’s	the	foundation	on	which	everything	else	rests,	and	without	it,	a	game	simply	won’t	feel	complete	or	convincing.	So	what	makes	good	character	animation?There	are	a	few
things	to	consider,	but	at	its	core,	good	character	animation	is	based	on	realism.	That	means	animating	characters	in	such	a	way	that	they	look	like	they’re	moving	around	in	3D	space	–	and	not	just	fixed	points	on	a	2D	plane.To	achieve	this	level	of	realism,	developers	need	to	have	a	solid	understanding	of	how	human	bodies	move.	This	knowledge	can
be	gleaned	from	years	of	experience	working	with	actors	and	motion	capture	technology	–	but	it’s	also	essential	to	remember	that	not	everyone	looks	or	moves	the	same	way.6.	GraphicsGraphics	are	an	essential	part	of	setting	up	a	2D	Unity	game.	They	can	convey	the	mood	and	feel	of	the	game,	as	well	as	helping	players	to	understand	what	is	taking
place	on	screen.	There	are	many	different	ways	to	use	graphics	in	a	Unity	game,	and	it’s	essential	to	choose	the	right	approach	for	each	situation.One	way	to	use	graphics	is	to	create	simple	images	or	icons	that	represent	different	objects	or	characters	in	the	game.	You	can	also	use	graphics	to	create	detailed	3D	models	of	characters	or	scenery	and
then	use	these	models	as	textures	on	2D	objects.You	can	also	create	2D	sprites	that	you	can	use	to	represent	different	object	types	in	your	game.	It’s	essential	to	consider	the	overall	design	of	your	game	when	choosing	which	type	of	graphics	to	use.7.	Physics	2DPhysics	plays	a	vital	role	in	setting	up	2D	Unity	Games.	In	this	article,	we	will	be
discussing	the	concept	of	Physics	in	Unity	and	how	it	can	be	used	to	create	realistic	games.	Physics	in	Unity	is	a	powerful	tool	that	allows	developers	to	create	games	with	high	levels	of	realism.By	understanding	the	concepts	involved	in	Physics,	you	can	create	games	that	are	both	visually	and	mechanically	complex.	2D	Games	are	a	popular	genre	of
game	development,	and	Physics	plays	a	vital	role	in	setting	up	these	games.In	2D	Games,	the	player	typically	views	the	game	world	from	a	fixed	perspective.	As	such,	physics	is	vital	in	establishing	how	objects	move	and	interact.	Without	accurate	physics	simulation,	2D	Games	would	not	be	as	realistic	or	fun	to	play.One	of	the	most	common	uses	for
Physics	in	Unity	is	collision	detection	between	objects.8.	AudioAudio	is	one	of	the	essential	concepts	in	setting	up	a	2D	Unity	Game.	It	plays	a	significant	role	in	the	game	by	providing	the	players	with	feedback	on	their	actions.Some	of	the	significant	components	that	you	need	to	consider	for	audio	are:Music:	Music	is	a	crucial	component	of	any	game,
and	it	plays	a	vital	role	in	setting	up	a	mood	for	your	game.Sound	effects:	Sound	effects	are	also	significant	as	they	provide	feedback	to	the	player	about	their	actions	in	the	game	and	their	environment.Ambient	sound:	Ambient	sound	can	set	up	moods	and	provide	some	depth	to	your	world	by	adding	background	noise	or	sound	effects	for	events
happening	around	them	(e.g.,	birds	chirping	and	water	flowing).9.	User	InterfaceUser	Interface	(UI)	is	one	of	the	concepts	in	setting	up	2D	Unity	Game	development.	UI	design	is	essential	for	creating	a	good	user	experience	and	ensuring	that	the	game	is	easy	to	use.	A	well-designed	UI	can	help	players	learn	how	to	use	the	game	controls	and
navigate	through	the	game	interface.There	is	a	range	of	different	UI	elements	that	you	can	use	in	your	game,	from	simple	icons	and	text	panels	to	full-blown	graphical	user	interfaces	(GUIs).	It’s	essential	to	choose	the	right	UI	element	for	your	game	and	ensure	it	looks	good	on	all	platforms	and	devices.Creating	a	good	UI	involves	planning	and
design,	as	well	as	programming	skills.	You’ll	need	to	create	custom	scripts	or	code	modules	to	handle	various	aspects	of	the	UI,	such	as	displaying	information	or	controlling	gameplay	actions.10.	Profiling,	Optimising,	and	TestingSetting	up	a	2D	Unity	game	is	a	great	way	to	learn	Unity	and	develop	your	skills	as	a	game	developer.	However,	it	can	be
challenging	to	know	where	to	start	when	it	comes	to	optimising,	profiling,	and	testing	your	game.Profiling	is	gathering	performance	data	about	your	game	to	identify	areas	that	could	be	improved.	This	data	can	help	you	identify	bottlenecks	and	optimise	your	code	accordingly.By	optimising	your	code,	you	can	improve	the	performance	of	your	game	by
reducing	the	number	of	unnecessary	calls	to	the	CPU	or	GPU.Testing	is	an	essential	step	in	ensuring	that	your	game	runs	smoothly	on	all	platforms	and	devices.ConclusionIn	conclusion,	Unity	is	an	excellent	tool	for	making	2D	games.	Many	free	and	commercial	software	packages	make	creating	Unity	games	easy.	However,	there	are	also	many	tips
and	tutorials	available	online	which	can	make	learning	Unity	even	simpler.So	if	you’re	interested	in	making	your	own	2D	Unity	game,	start	learning	today!FAQsIs	Unity	easier	to	use	for	making	2D	games?The	development	of	2D	games	is	also	easier	than	3D	games.	Since	2D	games	are	less	complex,	they	require	less	time	and	money	to	develop	and	can
be	updated	more	easily.Is	it	possible	to	make	a	2D	game	without	coding	in	Unity?You	can	use	Adventure	Creator	to	create	2D,	2.5D,	and	3D	games	in	Unity	without	coding.	Programmers	can	plug	and	play	their	features	into	the	visual	scripting	system	and	intuitive	Editor	of	this	game,	which	enables	beginners	to	build	an	entire	game	without	writing	a
single	line	of	code.How	much	does	Unity	2D	cost?50%	of	all	mobile	games	have	been	made	with	Unity	–	it	is	the	most	popular	platform	for	creating	2D	and	3D	games!	The	free	version	of	Unity	can	be	downloaded	by	new	users.	With	our	incredible	community	and	us,	you’ll	have	access	to	a	platform	for	creating	2D	games.	Before	you	create	a	2D	game,
you	need	to	decide	on	a	game	perspective	and	an	art	style.	To	create	a	2D	game,	set	up	your	Unity	project	and	then	familiarize	yourself	with	the	relevant	concepts	in	the	following	order:	Fundamentals	GameObjectsThe	fundamental	object	in	Unity	scenes,	which	can	represent	characters,	props,	scenery,	cameras,	waypoints,	and	more.	A	GameObject’s
functionality	is	defined	by	the	Components	attached	to	it.	More	infoSee	in	Glossary	are	fundamental	objects	in	Unity	that	represent	characters,	props,	scenery,	and	more.	Every	object	in	your	game	is	a	GameObject.	GameObjects	represent	the	items	in	your	game;	the	space	in	which	you	place	them	to	build	your	level	is	called	a	sceneA	Scene	contains
the	environments	and	menus	of	your	game.	Think	of	each	unique	Scene	file	as	a	unique	level.	In	each	Scene,	you	place	your	environments,	obstacles,	and	decorations,	essentially	designing	and	building	your	game	in	pieces.	More	infoSee	in	Glossary.	Scenes	in	Unity	are	always	3D;	when	you	make	a	2D	game	in	Unity,	you	typically	choose	to	ignore	the
third	dimension	(the	z-axis)	but	you	can	also	use	it	in	special	cases,	for	example	when	making	2.5D	games.	The	behavior	of	GameObjects	is	defined	by	blocks	of	functionality	called	components.	The	following	components	are	fundamental	for	2D	games:	Transform:	the	Transform	componentA	Transform	component	determines	the	Position,	Rotation,	and
Scale	of	each	object	in	the	scene.	Every	GameObject	has	a	Transform.	More	infoSee	in	Glossary	determines	the	Position,	Rotation,	and	Scale	of	each	GameObject	in	the	scene.	Every	GameObject	has	a	Transform	component.	Sprite	RendererA	component	that	lets	you	display	images	as	Sprites	for	use	in	both	2D	and	3D	scenes.	More	infoSee	in
Glossary:	the	Sprite	Renderer	component	renders	the	Sprite	and	controls	how	it	looks	in	a	scene.	CamerasA	component	which	creates	an	image	of	a	particular	viewpoint	in	your	scene.	The	output	is	either	drawn	to	the	screen	or	captured	as	a	texture.	More	infoSee	in	Glossary:	devices	that	capture	and	display	the	world	to	the	player.	Marking	a
Camera	as	Orthographic	removes	all	perspective	from	the	Camera’s	view.	This	is	mostly	useful	for	making	isometric	or	2D	games.	Collider	2D:	this	component	defines	the	shape	of	a	2D	GameObject	for	the	purposes	of	physical	collisionsA	collision	occurs	when	the	physics	engine	detects	that	the	colliders	of	two	GameObjects	make	contact	or	overlap,
when	at	least	one	has	a	Rigidbody	component	and	is	in	motion.	More	infoSee	in	Glossary.	See	2D	Physics.	Components	are	UI(User	Interface)	Allows	a	user	to	interact	with	your	application.	Unity	currently	supports	three	UI	systems.	More	infoSee	in	Glossary	representations	of	C#	classes;	you	can	use	scripts	to	change	and	interact	with	components,
or	create	new	ones.	See	the	Scripting	section	for	more	details.	Scripting	All	2D	games	need	scriptsA	piece	of	code	that	allows	you	to	create	your	own	Components,	trigger	game	events,	modify	Component	properties	over	time	and	respond	to	user	input	in	any	way	you	like.	More	infoSee	in	Glossary.	Scripts	respond	to	input	from	the	player	and	arrange
for	events	in	the	gameplay	to	happen	when	they	should.	For	details	on	how	to	use	scripts	in	Unity	see	Scripting	Overview.	Also	see	the	Unity	Learn	Beginner	Scripting	course.	Scripts	are	attached	to	GameObjects,	and	any	script	you	create	inherits	from	the	MonoBehaviour	class.	Sprites	Sprites	are	2D	graphic	objects.	You	use	Sprites	for	all	types	of
2D	games.	For	example,	you	can	import	an	image	of	your	main	character	as	a	Sprite.	A	character	Sprite	You	can	also	use	a	collection	of	Sprites	to	build	a	character.	This	allows	you	greater	control	over	the	movement	and	animation	of	your	characters.	Multiple	Sprites	that	make	up	the	parts	of	a	character,	displayed	in	the	Sprite	Editor	Importing	and
setting	up	Sprites	Import	your	Sprites	with	Unity’s	recommended	settings;	see	Importing	and	Setting	Up	Sprites.	Rendering	Sprites	Use	the	Sprite	Renderer	component	to	render	your	Sprites.	For	example,	you	can	use	the	Sprite	Renderer	to	change	the	color	and	opacity	of	a	Sprite.	Adjusting	the	color	of	a	Sprite	with	the	Sprite	Renderer	See	the
Introduction	to	the	Sprite	Renderer	Learn	tutorial.	Sorting	SpritesBy	organizing	Sprites	in	layers,	you	can	create	an	illusion	of	depth.	You	can	sort	Sprites	according	to	many	strategies.	See	Sorting	Sprites	for	full	details.	For	example,	you	might	sort	Sprites	along	the	y-axis,	so	that	Sprites	that	are	higher	up	are	sorted	behind	Sprites	that	are	lower,	to
make	the	Sprites	that	are	higher	appear	further	away	than	the	Sprites	that	are	lower.	Sprites	sorted	along	the	y-axis	To	set	the	overlay	order	of	Sprites,	use	Sorting	Layers.	To	group	GameObjects	with	Sprite	Renderers,	and	control	the	order	in	which	they	render	their	Sprites,	use	Sorting	Groups.	Sprite	Atlas	You	can	use	a	Sprite	AtlasA	texture	that	is
composed	of	several	smaller	textures.	Also	referred	to	as	a	texture	atlas,	image	sprite,	sprite	sheet	or	packed	texture.	More	infoSee	in	Glossary	to	consolidate	several	Textures	into	a	single	combined	Texture.	This	optimizes	your	game	and	saves	memory.	For	example,	you	can	add	all	your	Sprites	associated	with	a	particular	character	or	purpose	to	a
Sprite	Atlas.	A	Sprite	Atlas	See	the	Introduction	to	the	Sprite	Atlas	Learn	tutorial.	Building	in-game	environments	Environment	design	refers	to	the	process	of	building	your	game’s	levels	and	environments.	You	can	combine	the	environment	design	tools	in	this	section	in	whichever	way	makes	the	most	sense	for	your	game;	for	example,	you	can	make	a
top-down	game	using	only	9-slice,	or	you	can	make	a	side	on	platformer	with	Tilemap	and	SpriteShape.	9-slicing	9-slicing	is	a	2D	technique	that	allows	you	to	reuse	an	image	at	various	sizes	without	needing	to	prepare	multiple	assets.	Unity	can	dynamically	stretch	and	tile	designated	parts	of	a	Sprite	to	allow	one	Sprite	to	serve	as	the	border	or
background	for	UI	elements	of	many	sizes.	See	9-slicing	sprites.	For	example,	you	could	use	9-slicing	to	stretch	a	Sprite	to	shape	when	you	build	a	2D	level.	A	9-sliced	Sprite,	split	into	nine	sections	See	the	Using	9-Slicing	for	Scalable	Sprites	Learn	tutorial.	Tilemap	The	TilemapA	GameObject	that	allows	you	to	quickly	create	2D	levels	using	tiles	and	a
grid	overlay.	More	infoSee	in	Glossary	component	is	a	system	that	stores	and	handles	Tile	assets	for	creating	2D	levels.	Use	the	2D	Tilemap	Editor	package	(installed	by	default)	to	use	Tilemaps.	For	example,	you	can	use	Tilemaps	to	paint	levels	using	Tiles	and	brush	tools	and	define	rules	for	how	Tiles	behave.	The	Tile	Palette	window,	used	to	edit
Tilemaps	See	the	Introduction	to	Tilemaps	Learn	tutorial.	2D	Tilemap	Extras	To	add	some	extra	Tilemap	assets	to	your	Project,	install	the	2D	Tilemap	Extras	package.	This	package	contains	reusable	2D	and	Tilemap	Editor	scripts	that	you	can	use	for	your	own	Projects.	You	can	customize	the	behavior	of	the	scripts	to	create	new	Brushes	that	suit
different	scenarios.	Isometric	Tilemaps	For	games	with	isometric	perspective,	you	can	create	Isometric	Tilemaps.	SpriteShape	In	a	similar	way	to	a	vector	drawing	tool,	SpriteShape	provides	a	more	flexible	way	to	create	larger	Sprites,	such	as	organic-looking	landscapes	and	paths.	See	the	Sprite	Shape	Profile.	A	path	created	in	SpriteShape	See	the
Working	with	SpriteShape	tutorial.	Character	animation	There	are	three	different	ways	you	can	animate	2D	characters:	2D	animation	type	Used	for	Frame-by-frame	Artistic	reasons,	if	you	want	your	game	to	have	a	classic	animation	art	style.	Frame-by-frame	animation	is	relatively	resource-intensive,	both	to	make	and	to	run.	Cutout	Smooth	skeletal
animation,	when	the	characters	don’t	require	realistic	articulation.	Skeletal	Smooth	skeletal	animation	where	Sprites	bend	according	to	the	bone	structure.	Use	this	when	the	characters	need	a	more	organic	feel.	Frame-by-frame	Frame-by-frame	animation	is	based	on	the	traditional	cel	animation	technique	of	drawing	each	moment	of	an	animation	as
individual	images,	which	are	played	in	fast	sequence,	like	flipping	pages	on	a	flipbook.	To	do	frame-by-frame	animation,	follow	the	Frame-by-frame	Animation	workflow.	Frame-by-frame	animation	in	the	Sprite	Editor	See	the	Introduction	to	Sprite	Animations	Learn	tutorial.	Cutout	In	cutout	animation,	multiple	Sprites	make	up	the	body	of	a	character,
and	each	piece	moves	to	give	the	visual	effect	of	the	whole	character	moving.	This	animation	style	is	similar	to	skeletal	animation	(see	below),	except	that	the	Sprites	don’t	bend.	Cutout	animation	in	the	Sprite	Editor	Skeletal	With	skeletal	animation,	you	map	a	Sprite	or	a	group	of	Sprites	onto	an	animation	skeleton.	You	can	create	and	define
animation	bones	for	characters	and	objects,	that	define	how	they	should	bend	and	move.	This	approach	allows	the	bones	to	bend	and	deform	the	Sprites,	for	a	more	natural	movement	style.	To	use	skeletal	animation,	you	need	to	use	the	2D	Animation	package	(installed	by	default).	For	a	2D	Animation	workflow,	including	a	guide	to	working	with	the
Bone	Editor,	see	the	2D	Animation	documentation.	A	character	with	bones	in	the	Bone	Editor	Graphics	This	section	describes	your	graphics	options	when	using	Universal	Render	PipelineA	series	of	operations	that	take	the	contents	of	a	Scene,	and	displays	them	on	a	screen.	Unity	lets	you	choose	from	pre-built	render	pipelines,	or	write	your	own.
More	infoSee	in	Glossary	(URP).	Lighting	Because	you’re	using	URP	with	the	2D	Renderer,	you	can	use	the	Light	2D	component	to	apply	optimized	2D	lighting	to	Sprites.	For	details,	see	Introduction	to	Lights	2D.	These	two	images	show	the	same	scene;	in	the	image	on	the	left,	2D	Lights	are	disabled,	and	in	the	image	on	the	right,	2D	lights	are
enabled.	With	2D	Lights,	you	can	use	the	same	Sprites	to	create	different	weather	conditions	or	moods.	To	set	up	lighting:	See	the	Lighting	in	URP	Learn	tutorial.	Shadows	To	define	the	shape	and	properties	that	a	Light	uses	to	determine	the	shadows	it	casts,	use	the	Shadow	Caster	2D	component.	Increase	the	Light’s	Shadow	Intensity	above	zero.	A
shadow	intensity	of	0.5	in	the	Shadow	Caster	2D	component	Enhanced	look	and	feel	Particle	systems	and	post-processingA	process	that	improves	product	visuals	by	applying	filters	and	effects	before	the	image	appears	on	screen.	You	can	use	post-processing	effects	to	simulate	physical	camera	and	film	properties,	for	example	Bloom	and	Depth	of
Field.	More	info	post	processing,	postprocessing,	postprocessSee	in	Glossary	are	optional	tools	that	you	can	use	to	add	polish	to	your	game.	Particle	systems	You	can	use	particle	systems	to	create	dynamic	objects	like	fire,	smoke	or	liquids,	as	an	alternative	to	using	a	Sprite.	Sprites	are	more	suited	to	physical	objects.	See	Particle	systemsA	component
that	simulates	fluid	entities	such	as	liquids,	clouds	and	flames	by	generating	and	animating	large	numbers	of	small	2D	images	in	the	scene.	More	infoSee	in	Glossary.	A	fire	effect,	created	with	the	Particle	System	and	Shader	Graph	for	2D	Post-processing	You	can	use	post-processing	effects	and	full-screen	effects	to	significantly	improve	the
appearance	of	your	game.	For	example,	you	can	use	these	effects	to	simulate	physical	camera	or	film	properties,	or	to	create	stylized	visuals.	URP	has	its	own	post-processing	implementation.	See	Post-processing	in	the	Universal	Render	Pipeline.	The	Lost	Crypt	demo	uses	the	bloom	and	vignette	post-processing	effects	Physics	2D	The	Physics	2D
settings	define	limits	on	the	accuracy	of	the	physical	simulation	in	your	2D	game.	See	2D	Physics.	This	video	provides	an	overview	of	2D	physics	features	in	Unity	2020.1.	To	learn	how	to	use	Unity’s	2D	physics	engineA	system	that	simulates	aspects	of	physical	systems	so	that	objects	can	accelerate	correctly	and	be	affected	by	collisions,	gravity	and
other	forces.	More	infoSee	in	Glossary,	see	the	2D	Physics	Learn	tutorial.	The	following	2D	physics	tools	are	useful	for	2D	games.	Rigidbody	2D	Collider	2D	Triggers	2D	Joints	2D	Effectors	Rigidbody	2D	A	RigidbodyA	component	that	allows	a	GameObject	to	be	affected	by	simulated	gravity	and	other	forces.	More	infoSee	in	Glossary	2D	component
places	a	GameObject	under	the	control	of	the	physics	engine.	See	Rigidbody	2D.	The	Rigidbody	2D	component	Collider	2D	Collider	2D	components	define	the	shape	of	a	2D	GameObject	for	the	purposes	of	physical	collisions.	You	can	also	use	ColliderAn	invisible	shape	that	is	used	to	handle	physical	collisions	for	an	object.	A	collider	doesn’t	need	to	be
exactly	the	same	shape	as	the	object’s	mesh	-	a	rough	approximation	is	often	more	efficient	and	indistinguishable	in	gameplay.	More	infoSee	in	Glossary	2D	components	for	input	detection.	For	example,	in	mobile	games	you	can	use	them	to	make	Sprites	selectable.	The	Collider	2D	types	that	you	can	use	with	Rigidbody	2D	are:	The	Circle	Collider	2D
component	Triggers	When	you	set	a	Collider	2D	as	a	Trigger	(by	enabling	its	Is	Trigger	property),	it	no	longer	behaves	as	a	physical	object,	and	it	can	intersect	with	other	Colliders	without	causing	a	collision.	Instead,	when	a	Collider	enters	its	space,	Unity	calls	the	OnTriggerEnter	function	on	the	Trigger	GameObject’s	scripts.	The	Circle	Collider	2D
component	with	Is	Trigger	selected	2D	Joints	Joints	attach	GameObjects	together.	You	can	only	attach	2D	jointsA	physics	component	allowing	a	dynamic	connection	between	Rigidbody	components,	usually	allowing	some	degree	of	movement	such	as	a	hinge.	More	infoSee	in	Glossary	to	GameObjects	that	have	a	Rigidbody	2D	component	attached,	or
to	a	fixed	position	in	world	space.	See	2D	Joints.	2D	Effectors	Use	Effector	2D	componentsA	functional	part	of	a	GameObject.	A	GameObject	can	contain	any	number	of	components.	Unity	has	many	built-in	components,	and	you	can	create	your	own	by	writing	scripts	that	inherit	from	MonoBehaviour.	More	infoSee	in	Glossary	with	Collider	2D
components	to	direct	the	forces	of	physics	in	your	scene	when	GameObject	Colliders	come	into	contact	with	each	other.	See	2D	Effectors.	Audio	You	can	add	background	music	and	sound	effects	to	your	game	in	Unity;	see	Audio	Overview.	Use	third-party	software	to	create	your	audio	and	import	it	into	Unity	with	the	recommended	settings.	User
interface	If	you	want	to	add	a	menu	or	help	to	your	game,	you	need	to	set	up	a	user	interface.	To	set	up	a	user	interface,	use	Unity	UI.	Profiling,	optimizing	and	testing	a	build	Profiling	Profiling	allows	you	to	see	how	resource-intensive	the	different	parts	of	your	game	are.	You	should	always	profile	your	game	on	its	target	release	platform;	see	Profiling
your	application.	Optimizing	After	profiling,	you	can	use	the	results	to	make	performance	improvements	and	optimizations.	See	Understanding	optimization	in	Unity.	Testing	Test	your	game	and	your	code	with	the	Unity	Test	Framework;	see	Unity	Test	Framework.	The	Test	Runner	window	Publishing	When	you’ve	finished	your	game,	you’re	ready	to
publish	it.	See	Publishing	Builds.	The	Build	Settings	window	Unity’s	2D	suite	is	a	comprehensive	solution	that	includes	worldbuilding,	characters,	graphics,	physics,	and	more	for	making	2D	games	across	platforms.	Create	immersive	2D	worlds	directly	in	the	Editor	using	artist-friendly	and	powerful	features.	Make	rich,	free-form	organic	worlds	driven
by	splines	with	2D	SpriteShape.	Build	large	grid-based	worlds	with	2D	Tilemap	using	square,	hexagonal,	or	isometric	tiles.Empower	your	artists	with	procedurally	driven	SpriteShapes,	Tilemap	tiles,	and	brushes.	Use	code	to	generate	complete	worlds	or	boost	productivity	by	automating	various	aspects	of	painting	and	layout.	Both	2D	SpriteShape	and
the	2D	Tilemap	Editor	offer	complete	APIs,	documentation,	and	compatibility	with	many	other	Unity	systems.Build	2D	characters	right	in	Unity	using	the	2D	suite’s	complete	character	creation	and	animation	features.Work	with	multilayered	source	art	using	the	2D	PSD	Importer.	This	imports,	separates,	and	slices	up	the	various	parts	of	a	character,
then	automatically	reconstructs	it	as	a	Prefab	ready	for	further	rigging	and	animation.Create	flipbook	characters	with	a	powerful	asset	pipeline,	and	start	animating	almost	immediately	using	automatically	generated	keyframes.Create	deformable	characters	using	skin	and	bones.	You	can	perform	partial	or	full	character	skin	swaps	efficiently	at
runtime,	and	2D	Inverse	Kinematics	lets	you	animate	2D	characters	in	the	Editor.Render	atmospheric	visuals	that	bring	a	scene	to	life	with	2D	Lights.	Play	with	the	contrast	of	lights’	colors,	intensity,	and	placement	to	build	a	mood,	and	control	interaction	with	sprites	using	native	Sorting	Layers.Create	depth	in	graphics	with	highly	expressive	2D



Shadow	features	that	add	depth	and	texture	to	a	scene.Push	the	limits	of	2D	graphics	with	custom	shaders	in	Shader	Graph	that	incorporate	your	very	own	rendering	algorithm,	and	create	dynamic	scene	effects	with	VFX	Graph.	For	a	dash	of	nostalgia,	render	everything	in	Pixel	Perfect,	which	is	supported	natively	in	the	Unity	Editor.Unity	comes
with	dedicated	and	optimized	2D	physics,	with	many	more	features	and	optimizations	to	power	your	game.2D	Colliders	enable	accurate	detection	of	your	sprites’	shapes,	from	primitive	to	custom	shapes.	If	they	also	include	a	Rigidbody	2D,	the	objects	will	react	to	gravity	and	behave	as	solid	objects.Objects	anchored	to	another	object	also	can	benefit
from	physics	with	2D	Joints,	adding	realism	to	a	sliding	platform,	chain,	spring,	or	car.Do	you	want	to	simulate	buoyancy	or	magnets?	2D	Effectors	can	add	non-contact	physics	effects.Set	up	and	optimize	art	assets	for	your	2D	projects.	Slice,	tile,	adjust	the	pivot,	redefine	shapes,	or	add	normal	and	mask	texture	sprites,	all	within	the	Sprite
Editor.Optimize	your	2D	game	with	Sprite	Atlas,	which	enables	you	to	pack	your	sprites	into	one	texture	to	save	draw	calls	and	resize	based	on	your	target	platform.To	further	optimize	and	debug	your	game,	you	can	use	Unity	profiling	tools	like	the	Profiler,	Frame	Debugger,	or	Rendering	Debugger.


